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PowerPoint is a complete digital (electronic) presentation package.  It gives you everything you 
need to produce a professional presentation.  With PowerPoint you can create and display sets of 
slides that combine text with drawn objects, clip art, photos, sound, video and even animated 
special effects.  Furthermore, because PowerPoint is part of the Microsoft Office package, you 
can easily blend Word outlines, Excel worksheets, charts, graphics and artwork into your own 
original text and graphics to create a dynamic and informative electronic slide show.     
 

1) When PowerPoint is opened, an initial screen appears which gives you the option of creating a 
new presentation using the AutoContent Wizard, Design Template or Blank Presentation.   

 
QUICK TIP: If you have not used the PowerPoint program before, it is recommended 
that you start out by choosing the Design Template option.  The design template is 
simply a predetermined theme, which contains color schemes, custom formatting and 
styled fonts designed to create a particular look. 
 

Click on “Create a new presentation…” located on the “Getting Started”  task pane.   
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2) The “New Presentation”  task pane will appear.  Click on “From design template”  to select a 
predetermined theme. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3) The “Slide Design”  task pane will appear.   
 

 
A window containing all of the design templates will appear.  
By clicking on each icon, you can see a preview of how the 
design will appear in your PowerPoint presentation, as it will 
appear on the slide located in the center of the screen (see 
image below).  Choose the design template that you would 
like to use and click on the icon to apply it to your slide. 
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4) On the Title Page slide, click in the top box to type the title of your presentation.  Click in the 
second box to type additional content you want on the Title Page slide.  Often this is where a 
presenter will place his/her name, date and/or the organization he/she represents. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5) After you have completed your title page, you will want to create a New Slide.  You can do 
this one of two ways. 
 
     A. Dropdown from the Inser t menu to New Slide.   
 
     B. On the Common Tasks toolbar, click New Slide.   

 
6) The “Slide Layout”  task pane will appear.  The “Apply slide layout:”  window contains a 
variety of slide layouts.  Select the layout for your new slide and click the icon.  Please Note: 
Each slide layout’s name/label will appear in the lower right hand corner of the icon when you 
mouse over it.  As a novice, you will use the Title Page and Bulleted L ist layouts the most.  As 
you begin to feel more comfortable with PowerPoint, experiment with other slide layouts.  

 
As in step 4, you will click within the boxes to add text.  Repeat steps 5 – 6 
for each additional slide. 
 

QUICK TIP: Please remember to save your work often, as 
 work could be lost due to power outages, computer errors, etc.   
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7) To view your presentation as a slide show, click on the icon (located at the bottom left of the 
screen) that looks like a presentation screen  or go to View �  Slide Show.  You can navigate 
through the slide show by left clicking on the computer mouse or by using the arrow keys on 
your keyboard.  If at any time you would like to end the slide show, click the “Escape” (Esc) key 
on your keyboard.   
 

QUICK TIP: To check spelling within a slide at any time, click the Spelling    icon on 
the Toolbar or drop down from the Tools menu to Spelling.     
 
 

Internet hyperlinks provide a simple way for you to link to content on the Internet such as a web 
page containing a research article, a page of images related to your topic or your departmental 
home page.  You can also use hyperlinks to open a file in MS Word or other local programs.   
 
1) Highlight the word or phrase that you would like to serve as a link.  It usually works best if 
    that word or phrase is a descriptive label that relates to the purpose of the link.  This allows 
    users to know in advance what they are connecting to.  For example, “Check Scores on the 
    Web” or “Study Guide for AASU 1101 – Test 1.”  
 

2) Drop down from the Inser t menu to Hyper link or click on the Insert Hyperlink    icon at 
the top of the page. 
 
3) Type in the Address (i.e., http://www.armstrong.edu) to link to a web page, or click on the 
Browse button to browse to the file that you would like your linked text to display.  
 
4) Click the OK button.  The text will appear as underlined type.  When you run the 
    presentation, the underlined text will be a link that you can activate with a single click. 
 

QUICK TIP: It is best to save files that you would like to link to within the same folder 
that contains your PowerPoint presentation.  This will allow for easier browsing as well 
as simplifying the task of saving everything to a disk if you can’ t take your computer 
with you.     

 
 

Because PowerPoint is part of the Microsoft Office package, you will find that formatting font, 
font size and/or color is done much the same way as it is done in Word.  To change the font, font 
size or color, highlight the text that you would like to change.  Dropdown from the Format 
menu to Font.  The Font dialog box will appear.  From here you can change your font, font 
style, font size and color.  In addition, you can choose effects such as Under line, Shadow, 
Emboss, Superscr ipt or Subscr ipt.  Once you have chosen the changes you would like to make 
to your text, click “OK.”    
 
Enhancing the text in a bulleted list on a slide is not the only way to add pizzazz to your 
presentation.  You can use other slide layouts and add graphics to your presentation—an 
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organization chart, a table, clip art or even your own images.  Adding graphics to your 
presentation will add interest as well as help you make your point quickly and effectively.     

When you want your audience to see, at a glance, who’s who within a department, school and/or 
college, you can create an organization chart that will display this hierarchy visually. 
 
1) Select the point at which you would like to insert the organization chart.  Drop down from the 
Inser t menu to Picture and then to Organization Chart or insert a new slide.  If you choose to 
insert a new slide, choose the slide titled “Title and Diagram or Organization Chart.”    
 

 
2) The Diagram Gallery dialog box will appear.  Select the organization chart and click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3) Select the Title Placeholder  and type a title for the organization chart slide. 
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4) Click in the Super ior  (top) box and type the name, title and/or any comments that you would 
like to appear within the box.  Add organizational information to the Subordinate boxes below.   
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
5) While adding information to the Super ior  box, the Organization Chart Toolbar  will appear.  
The Organization Chart Toolbar allows you to insert additional boxes (Subordinate, Coworker 
and Assistant) to your chart, change the layout of your chart and select different organization 
chart styles. In addition, if the text extends beyond the borders of the box, you can select the box 
and click “Fit Text.”   The text will be reformatted to fit within the borders of the box.     
 
 
 
 
 
 
 
 
 
Add, and/or rearrange other boxes and their information as necessary using the Organization 
Chart tools located in the toolbar.  To delete a box from the Organization Chart, select the box 
to be removed and click “ Delete”  on your keyboard or right click on your mouse and select 
“Delete.”    
 

QUICK TIP: Please remember that you do not have to use all the formatting options just 
because they are there.  It is usually a good idea to keep your organization chart simple 
and easy to read—like the one produced by the default settings. 
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1) Display the slide in which you are going to create a table. 

2) Dropdown from the Inser t menu to Table.  Specify the number of columns and rows that you 
will need alternately.  You may choose to insert a new slide.  If you choose to insert a new slide, 
choose the slide titled “Title and Table.”   
 
3) In the blank table, click in each cell and enter the data.  You can also move from cell to cell by 
using the Tab key or the arrow keys.  (When you reach the bottom of the table, pressing Tab 
adds additional rows to the table.) 
 
4) Since the table you’ve inserted comes directly from Word, notice that the menu bar 
and toolbar now contain Word commands.  Feel free to use Word’s formatting commands—
especially the commands on the Tables and Borders toolbar—to further customize your table. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1) Select a slide layout that has an appropriate placeholder by selecting the Title and Chart slide 
from the Slide Layout task pane.  In addition, you can add a chart to any slide by dropping down 
to Chart from the Inser t menu. 
 
2) Select the title placeholder and type a title for the chart. 
 
3) Double-click the chart icon in the middle of the slide.  The Datasheet window will appear.  
To customize this chart with your own information, modify the default chart one cell at a time, or 
highlight the chart, press Delete to clear all the default information, and rebuild the whole chart. 
 

QUICK TIP: It is recommended that you modify the datasheet one cell at a time until 
you are comfortable with the placement of the row and column labels. 
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4) If at any time you need to make changes to the chart, right-click on the chart and select 
“ Char t Object”  and click “ Open”  to make any changes.  Once you have made all necessary 
changes, close the “ Microsoft Graph”  dialog box to return to your slide. 
 
5) To format the chart, double-click within it.  A message window will appear.  Please note that 
you will receive different formatting options depending on where you click within the chart. 
From here, you can format the border, font, color, primary axis, secondary-axis, legend 
placement, etc. 
 
6) In addition, you can format your chart to be a pie chart, area chart, 3-D area chart, 3-D surface 
content chart, 3-D bar chart, scatter chart, etc.  Double-click on the Table.  Once the table is 
open for editing, you will notice that the menu bar at the top of the screen now contains the 
Chart menu.  Click on Chart and select Char t Type.  The Chart Type dialog box will appear.  
You can select from a variety of options such as Bar , L ine, Pie, Doughnut, and Scatter  charts 
as well as several others. 
 
 
 
 
 
 
7) Select the chart type that you would like to use and click OK.  The new chart style will now 
appear in your slide. 
 

1) Select a slide layout that has an appropriate placeholder by choosing a slide layout that 
contains clip art (“Clip Art”  will appear in the title of the slide layout).  Otherwise, you can add 
clip art to any slide by dropping down to Clip Ar t from the Inser t menu. 
 
2) Select the title placeholder and type a title for the slide. 
 
3) Add text within the text placeholder. 
  

4) Double-click on the clip art icon  in the  
center of the screen.  The Select Picture dialog 
box will appear. 
 
5) Search for the clip art image that you would  
like to use. 
 
6) Click once on the image and click OK.  The 
image will now appear in your slide. 
  
7) To format the image, right click on the picture  
and choose Format Picture.  From here, you can  
change colors and lines, size, background,  
layout, etc., as well as crop the image. 
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8) In addition to adding clip art, you can add your own images (images saved on your hard drive 
or on a disk).  First, select the slide on which you would like to add your image.  
 
9) Dropdown from the Inser t menu to Picture then to From File.  Browse for the image file that 
you would like to insert. 
 
10) Highlight the image that you would like to insert and then select Inser t from the lower 
right hand corner of the window.  The image will now be displayed on your slide.  You can 
move the image to a different location on your screen by grabbing the image with your cursor 
and dragging it to a different position on the screen.   
 
11) Like clip art, your image can be formatted by right clicking on the image and 
changing options.  In addition, you can right-click on the image and send it behind text or in 
front of text by choosing Order  ����  Send Backward (to place behind text) or Order  ����  Br ing 
Forward (to place in front of text).           

By default, the Drawing toolbar appears at the bottom of the PowerPoint window.  This toolbar 
is also available in Word and Excel; therefore, once you learn how to use it in one application, 
you will have the skills necessary to use it in all the Office programs.  If the Drawing toolbar is 
not visible, display it by selecting the View menu, dropdown to Toolbars and then Drawing.  
The Drawing toolbar is displayed below. 
 

 
1) Display the slide in which you wish to draw a graphic object. 
 
2) Click on one of the buttons on the Drawing toolbar to draw shapes, lines, etc.  
 
3) Use the formatting options (i.e., Change Fill Color , Change Font Color , L ine Style, 
Shadow Effects) to produce eye-catching graphics. 
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PowerPoint’s basic formatting effects create solid, compelling presentations.  However, if you 
really want to grab your audience’s attention, you may wish to consider adding one or more 
multimedia elements to your presentation.  By carefully balancing special effects—animation, 
music and/or sound—you can make your slide show explode with life and energy. 

   
   

PowerPoint enables you to add animation effects to your slides and to use transitions between 
slides.  Both of these make your slides appear more interesting and more energized.  By using 
animation, you can have each word fly in from one side of the slide, each paragraph seem to 
dissolve from the slide background, or any of a variety of other effects.  When you use slide 
transitions, you can have one slide dissolve into another, make one slide appear to “ iris”  open 
like a camera lens, or choose from several other intriguing transition options. 
 
1) Create your slide content first, adding text and graphic objects as you normally would.  For 
example, add a title, a bulleted list, and a piece of clip art to your slide.  You cannot create 
animation effects until your slide content is finished. 
 
 2) Dropdown from the Slide Show menu to Custom Animation.  The Custom Animation task 
pane will appear on the right hand side of the screen.  From here you can choose animation 
effects as well as sound effects to add to your title, text, and/or graphics.  In addition, you can 
choose the order and timing of your effects.  Before selecting effect, start time, direction and 
speed, select the text or image in your slide that you would like to add the effect to.   
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3) To add sound to an effect, click on the Effect Options dropdown menu next to the effect 
selected and click Effect Options.  A dialog box will appear (name of the dialog box will be 
determined by the effect that you have chosen to apply to your text and/or image). 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on the Sound dropdown menu and select the sound that you would like to apply to your 
animation.  Make changes to other settings (i.e., After animation, Animate text) as appropriate 
and click OK. 
 
4) To add transitions between slides, dropdown from the Slide Show menu to Slide Transition.  
The Slide Transition task pane will appear on the right hand side of the screen. 
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5) On the left hand side of the screen, click the Slides Tab.  All of your slides will appear within 
this window as thumbnails.  Select the slide thumbnails that you would like to apply slide 
transitions to and make your selections on the right hand side under the Slide Transition task 
pane.  Click Play at the bottom of the Slide Transition task pane to preview your animation 
selections. 
 

  
If you have a CD ROM drive installed in your computer, you can add CD music tracks to your 
PowerPoint presentations.  However, you can only add music tracks to slides.  The music track 
will not attach to objects, animations or transitions.  
 
1) Insert CD into the CD ROM drive.  
 
2) In Slide View, display the slide to which you would like to add music. 
 
3) From the Inser t menu, choose Movies and Sounds ����  Play CD Audio Track.  The Inser t 
CD Audio dialog box will appear. 
 
4) Under Clip selection, enter the music track number in the Star t and End at track boxes 
provided.  For example, to add the first two tracks of the CD, type “1”  in the Star t at track box 
and “2”  in the End at track box.  If you want to play just the first 35 seconds of the track, type 
35 seconds in the End at track box. 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
5) Once you have specified your track and duration times, click “OK.”   A CD icon will appear in 
the middle of your slide.  You can resize the icon or move it to another location on the slide.   
 
6) Before playing the CD track, make sure the CD is in the CD ROM drive; otherwise, the music 
will not play.  To play the CD track, double-click on the CD icon.  In addition, you can make the 
music play automatically if you place the CD icon in the animation order (see Adding Custom 
Animation).  
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To preview your presentation from the beginning, select the first slide of your presentation and 
click on the Slide Show View  button.  To exit your presentation at any time, hit Escape on 
your keyboard.  
 
 

1) Click the Slide Sor ter   icon or choose Slide Sor ter  from the View menu. 
 
2) Click and hold your mouse button on the slide you wish to move 
 
3) Drag the slide to its new location and release the mouse button.  The vertical line indicates 
    where the slide will be placed. 
 
 

PowerPoint has a facility for adding speaker notes to a presentation.  These can be notes that you 
create for yourself—for example, to help you remember key points during a presentation—or 
you can create them as additional information for your audience.  After you have completed a 
presentation, you can print the notes for each slide, along with a smaller version of the slide. 
 
1) To add notes to a slide, select the slide on which you wish to insert notes.  Click in the Notes 
    Pane in the lower right of the PowerPoint screen and type your notes.  You can enlarge the 
    size of this pane by dragging its borders. 
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1) From the File menu, choose Pr int.  The print dialog box will appear. 
 
2) PowerPoint gives you several options for printing.  You can print slides, handouts, notes 
    pages, and/or outline views.  Choose the print options you prefer and click OK. 
 
 


